Augmented Reality

Augmented Reality is a tool that allows you to combine La-Z-Boy products with photos of real rooms. You’ll print a marker, photograph the room and upload the photo to the tool. You can try out different products and covers right in your space.

- Printing the Marker
- Using the Marker
- Uploading the Images

Select here to get more details.

Products Tab

The Products tab is a library of available La-Z-Boy products. Search by category and use filtration to narrow the list of available products by style, options or material. Use the play button to animate motion furniture.

- Adding a Product
- Configuring a Sectional
- Animating a Product
- Saving Your Workspace
- Load a Plan

Select here to get more details.

Modify Tab

A subset of the Product tab, the Modify tab lets you customize each product to create your perfect piece of furniture. Change the cover, try a new wood finish and even configure your own sectional, all in one workspace.

- Changing the Cover of a Product and/or Pillow
- Changing the Wood Finish of a Product
- Saving Your Workspace
- Displaying the Measurements of a Product
- Removing a Single Product or Sectional
- Removing a Unit from a Sectional

Select here to get more details.
Interior Design Tab

The Interior Design tab allows you to construct your own space. Choose from provided room shapes, upload a floorplan or create your own space to surround your products. Change your wall and floor materials, add doors and windows, and finish your floorplan by selecting from a wide range of accessories. View your floorplan in 3D or toggle to the overhead 2D view.

- Select a Theme Room
- Selecting a Room Layout
- Creating a Floorplan from an Image
- Creating a Floorplan from Scratch
- Viewing in 2D
- Editing a Floorplan from Room Layout
- Add Windows and Doors
- Remove Windows and Doors
- Displaying Floorplan or Product Measurements
- Apply Wall Colors and Flooring
- Adding Accessories
- Resizable Accessories
- Position a Fireplace in a Wall

Select here to get more details.

Products Tool Glossary

These tools help you add, view and alter a product.
Select here to get more details.

Interior Design Tool Glossary

These tools are located in the Interior Design tab and help you create and modify your floorplan.
Select here to get more details.

Workspace Tool Glossary

The functionality of these tools is specifically related to your workspace. They allow you to complete tasks such as saving your workspace, clearing product from the workspace and obtaining a list of product within your workspace.
Select here to get more details.

Shortcuts

These shortcuts allow you to add, move and alter products in sets.
Select here to get more details.
Augmented Reality

Augmented Reality is a tool that allows you to combine La-Z-Boy products with photos of real rooms. You’ll print a marker, photograph the room and upload the photo to the tool. You can try out different products and covers right in your space.

Printing the Marker

1. Single-click the Augmented Reality tab in the top navigation.

2. Within Use Photo, choose the Print the marker paper option in the right-side navigation.

3. The marker will present in a new window. Within the new window, select the print command.
Using the Marker

1. Place the marker in the middle of the room you wish to photograph. Be sure to place the marker correctly on the floor so the designated side is toward the camera.

2. Take a photograph of your room.
Uploading the Image
1. Single-click the Augmented Reality tab in the top navigation.

2. Browse for the image just taken. Select your image. When the image file is selected the name will appear in the text box.
3. With the image selected, select Add photo. Your photo will be added under the My Pictures dropdown.
4. Single-click the image from My Pictures that you wish to appear as the workspace.

5. To add products, click the Products tab and add your products.
Products Tab

The Products tab is a library of available La-Z-Boy products. Search by category and use filtration to narrow the list of available products by style, options or material.

Adding a Product

1. Single-click the Products tab on the top navigation.
2. Choose a product category on the top navigation or in the right-side navigation.
3. Use the filtration check boxes to narrow down the product options or navigate through each of the available products.
Configuring a Sectional

1. Single-click the Products tab on the top navigation.
2. Choose the Sectionals category on the top navigation or in the right-side navigation.
3. Use the filtration check boxes to narrow down the sectional options or navigate through each of the available styles.
4. Single-click the sectional style you wish to configure.
5. Single-click the product image you wish to add to the workspace.

**Please note:** after that product appears in the workspace, only products that are configurable with the currently selected product will appear on the right.

6. To add another product, single-click the product image on the right. The product will appear in grey in the workspace in any of its configurable locations. Single-click the grey unit in the location where you wish to attach the product to the sectional.

7. Repeat steps 5 and 6 until you have all of the pieces of the sectional you wish configured.
Animating a Product

1. Select the product to display the Product Alteration Menu.
2. Select the play button to begin the animation.

3. Select the product to display the Product Alteration Menu.
4. Select the play button a second time to finish the animation.
Saving Your Workspace

1. To save your workspace, make sure you have signed in. If you are not signed in, click the Sign in button in the top right side of the page. After signing in, choose the Save as button located at the bottom of the workspace.

2. After you have saved the workspace once, you can use the Save button located at the bottom of the workspace to save any additional changes to that workspace.
Load a Plan

1. To load a plan, make sure you have signed in. If you are not signed in, click the Sign in button in the top right side of the page. After signing in, choose the Load button located at the bottom of the workspace.

2. Your saved plans will appear in the Load room window. You can access additional folders by selecting the dropdown in the Choose folder field.

3. Single-click the image associated with the plan you wish to load to have it rendered in the workspace.

4. You can also use the unique ID to open a design by typing the ID in the Open by ID field and single-clicking the Load button.
5. To delete a saved plan, click the X in the upper right corner of the plan image. Then select Remove.
Modify Tab

A subset of the Product tab, the Modify tab lets you customize each product to create your perfect piece of furniture. Change the cover, try a new wood finish and even configure your own sectional, all in one workspace.

Changing the Cover of a Product and/or Pillow

1. Single-click the product to display the Product Alteration Menu.
2. Single-click the Product Modification Icon to open the Modify tab.

3. The Materials tab will be selected in the top right corner of the right-side navigation.

4. If the unit offers contrasting pillows, you must select the "radio" (circle) button in the right-side navigation of the area where you wish to have the cover applied.
   - **A.** Product and Options: Applies the same cover to both the product and pillows.
     - Please note: leather covered pillows are not available.
   - **B.** Product: Applies the cover to only the product, not the pillows.
   - **C.** Pillows: Applies the cover to only the pillows, not the product.

5. When there are two sets of contrasting pillows:
   - **a.** Inner Pillows will apply the cover to only the innermost pillows, not the outermost pillows nor the product.
   - **b.** Outer Pillows will apply the cover to only the outermost pillows, not the innermost pillows nor the product.

6. Use the filtration check boxes to narrow down the choices or use the scroll bar on the right side to navigate through the available covers. Choose your desired cover by single-clicking the cover image.

7. To complete the product, single-click the Exit modify button in the right-side navigation.
Changing the Wood Finish of a Product

1. Single-click the product to display the Product Alteration Menu.
2. Single-click the Product Modification Icon to open the Modify tab.
3. The Materials tab will be selected in the top right corner of the right-side navigation.

4. Single-click the Wood Finishes tab on the top right corner of the right-side navigation. **Please note:** if the Wood Finishes tab does not appear, there is either no wood on the product or no optional wood finishes for that product.

5. Choose your finish cover by single-clicking the wood finish image.

6. To complete the product, single-click the Exit Modify button.
Saving Your Workspace

1. To save your workspace, make sure you have signed in. If you are not signed in, click the Sign in button in the top right side of the page. After signing in, choose the Save as button located at the bottom of the workspace.

2. After you have saved the workspace once, you can use the Save button located at the bottom of the workspace to save any additional changes to that workspace.
Displaying the Measurements of a Product

1. Single-click the product to display the Product Alteration Menu. The style name, width, height and depth will be displayed in the top left corner of the workspace.

2. To see an overhead measurement, click the Product Modification Icon. This will open the Modify tab.

3. Single-click the Measurements button from the bottom workspace navigation.

4. Single-click the Exit modify button in the right-side navigation to return to the workspace.
Removing a Single Product or Sectional
1. Single-click the product to display the Product Alteration Menu.
2. Single-click the X icon.
Removing a Unit from a Sectional

1. Single-click the product to display the Product Alteration Menu.

2. Single-click the Product Modification Icon to open the Modify tab. Make sure the Base Elements tab is selected on the right-side navigation.

3. Select the unit you wish to remove from the sectional by single-clicking the unit. A red outline box should appear to identify the selected unit.

4. Single-click the Remove button from the bottom workspace navigation. 
   **Please note:** only outside units can be removed. To remove inner units, you must first remove any outside units to expose the inner unit. You can rebuild the sectional by using the products from the Base Elements tab on the right-side navigation.

5. Repeat the process until all of the desired units are removed.
6. When all desired units are removed, single-click the Exit modify button in the right-side navigation.
**Interior Design Tab**

The Interior Design tab allows you to construct your own space. Choose from provided room shapes, upload a floorplan or create your own space to surround your products. Change your wall and floor materials, add doors and windows, and finish your floorplan by selecting from a wide range of accessories. View your floorplan in 3D or toggle to the overhead 2D view.

**Select a Theme Room**

1. Select the Interior Design tab in the top navigation.
2. Select the Theme Room tab in the top navigation.
3. Select the image of the Theme Room that you wish to have rendered in the workspace from the right-side navigation.
Selecting a Room Layout

2. Single-click Room Layout in the top navigation.
3. Single-click one of the pre-loaded layout images in the right-side navigation that you wish to appear in the workspace.
4. To save your workspace, make sure you have signed in. If you are not signed in, click the Sign in button in the top right side of the page. After signing in, choose the Save as button located at the bottom of the workspace.

5. After you have saved the workspace once, you can use the Save button located at the bottom of the workspace to save any additional changes to that workspace.
Creating a Floorplan from an Image

2. Single-click Floorplan in the top navigation.
3. Single-click the Floorplan button in the bottom workspace navigation to upload an external floorplan in PNG, JPEG or DWG format. This will upload your image for reference points.

3A. Single-click the Browse button to choose the image from your computer.
3B. Single-click the Upload the image button to upload your selected plan.
3C. Left-click and hold to draw a measure line on one of the outer walls. Then provide the wall’s length in inches in the white text box.

3D. Single-click Use image to upload the image to the proportions specified, or click Change image to restart.

3E. Single-click the Custom Floorplan Toggle on the left side to hide or show your uploaded image in the background of the virtual room.
4. Single-click the Wall Tool from the left-side icons to add walls.
   
   **4A.** Left-click and hold on the starting point for your wall.
   
   **4B.** Drag your mouse to where you would like your wall to end and release. During the process, measurements will appear for the length of your wall and the angle from the starting point of your wall.
   
   **4C.** A dotted line will appear to indicate when you are lined up directly across from another wall start, end or joint.

5. Single-click the Select Tool from the left-side icons to create and change the room's layout.

   **5A.** Change walls:
   
   1. Left-click and hold the mouse over a wall.
   2. Slide the wall vertically and/or horizontally to achieve the new desired position.

   **5B.** Remove walls:
   
   1. Single-click to highlight the wall in blue and reveal an “X” option.
   2. Single-click the “X” to remove the wall.
6. Single-click the Split Floor Tool from the left-side icons to designate areas to apply different flooring.

6A. Left-click and hold on the starting point of your area.

6B. Drag your mouse to where you would like your section to end. During the process, measurements will appear for the length of your section and the angle from the starting point of your selection.

6C. Connect the lines either to each other or to a wall in order to section that area of the floor. Please note, if you leave a section that is not completely connected to a wall or another split line, the area will not take the additional floor treatment. All sections must be completely closed.
Creating a Floorplan from Scratch


2. Single-click the Floorplan tab in the top navigation.

3. Single-click the Wall Tool from the left-side icons to add walls.
   
   **3A.** Left-click and hold on the starting point for your wall.
   
   **3B.** Drag your mouse to where you would like your wall to end.

   1. During the process, measurements will appear for the length of your wall and the angle from the starting point of your wall.
   
   2. A dotted line will appear to indicate when you are lined up directly across from another wall start, end or joint.

4. Single-click the Select Tool from the left-side icons to create and change the room’s layout.

   **4A.** Change walls:

   1. Left-click and hold the mouse over a wall.
   
   2. Slide the wall vertically and/or horizontally to achieve the new desired position.
4B. Remove walls:
   1. Single-click to highlight the wall in blue and reveal an “X” option.
   2. Single-click the “X” to remove the wall.

5. Single-Click the Split Floor Tool from the left-side icons to designate areas to apply different flooring.
   5A. Left-click and hold on the starting point of your area.
   5B. Drag your mouse to where you would like your section to end. During the process, measurements will appear for the length of your section and the angle from the starting point of your selection.
5C. Connect the lines either to each other or to a wall in order to section that area of the floor. Please note, if you leave a section that is not completely connected to a wall or another split line, the area will not take the floor treatment. All sections must be completely closed.
**Viewing in 2D**


2. Single-click the Floorplan tab. This will show your rendering in 2D.

3. To view in 3D, single-click the Room Layout tab.


**Editing a Floorplan from Room Layout**


2. Single-click the Room layout tab in the top navigation.

3. Single-click one of the pre-loaded layout images in the right-side navigation that you wish to appear in the workspace.

4. Single-click the Floorplan tab on the top navigation.

5. Single-click the Select Tool from the left-side icons to create and change the room’s layout.

   5A. Change walls:
   
      1. Click and hold the mouse over a wall.
      
      2. Slide the wall vertically and/or horizontally to achieve the new desired position.

   5B. Remove walls:

      1. Single click to highlight the wall in blue and reveal an “X” option.
      
      2. Click the “X” to remove the wall.
6. Single-Click Wall Tool from the left-side icons to add your own walls.

   6A. Left-click and hold on the starting point for your wall.

   6B. Drag your mouse to where you would like your wall to end. During the process, measurements will appear for the length of your wall and the angle from the starting point of your wall.

   6C. A dotted line will appear to indicate when you are lined up directly across from another wall start, end or joint.
7. Single-click the Split Floor Tool from the left side to designate areas to apply different flooring.

7A. Left-click and hold on the starting point of your area.

7B. Drag your mouse to where you would like your section to end. During the process, measurements will appear of the length of your section and the angle from the starting point of your selection.

7C. Connect the lines either to each other or to a wall in order to section that area of the floor. Please note, if you leave a section that is not completely connected to a wall or another split line, the area will not take the additional floor treatment. All sections must be completely closed.
Add Windows and Doors


2. If you do not have a room layout selected, single-click the Room layout tab in the top navigation and single-click one of the pre-loaded layout images in the right-side navigation that you wish to appear in the workspace. If you have a room layout selected you may skip this step.

3. Single-click the Floorplan tab in the top navigation.

4. Single-click on the Windows or Doors dropdown in the right-side navigation.

5. Single-click the window or door image that you wish to appear in the workspace from the right-side navigation.
6. Alter the window or door dimensions using the slider options in the right-side navigation.

7. Hover over the location along a wall where you would like the window or door to appear. Single-click to have the window or door appear in the workspace.
Remove Windows and Doors

2. Single-click the Floorplan tab in the top navigation.
3. Single-click to highlight the window or door in blue and reveal an “X” option.
4. Click the “X” to remove the window or door.
Displaying Floorplan or Product Measurements

2. Single-click the Floorplan tab in the top navigation.
3. Single-click the Measure Tool from the left-side icons to display the measurements of all the walls in your workspace.

4. Left-click and hold on the starting point of your desired measurement.
5. Drag your mouse to where you would like your measurement to end and release.
   During the process, measurements will appear of the length and the angle from the starting point of your measurement.
Apply Wall Colors and Flooring

2. Single-click the Colors tab in the top navigation.
3. Single-click the Wall materials or Floor materials dropdown in the right-side navigation.
4. Single-click the wall or floor option that you wish to appear in the workspace from the right-side navigation.
5. Hover over the wall or area of the floor that you wish to apply the material to.
6. Single-click the wall or area of the floor to have the material applied.
7. To apply different flooring to different areas of the plan, single-click the Floorplan tab in the top navigation.

7A. Single-click the Split Floor Tool from the left-side icons to designate areas to apply different flooring.

7B. Left-click and hold on the starting point of your area in the virtual room.

7C. Drag your mouse to where you would like your section to end and release. During the process, measurements will appear for the length of your section and the angle from the starting point of your selection.

7D. Connect the lines either to each other or to a wall in order to section that area of the floor. Please note, if you leave a section that is not completely connected to a wall or another split line, the area will not take the additional floor treatment. All sections must be completely closed.

7E. Single-click the Colors tab in the top navigation.

7F. Single-click the Floor materials dropdown in the right-side navigation.

7G. Single-click floor option that you wish to appear in the workspace from the right-side navigation.

7H. Hover over the area of the floor that you wish to apply the material to.

7I. Single-click area of the floor to have the material applied.
Adding Accessories

2. Single-click the Accessories tab in the top navigation.
3. Single-click the accessory category dropdown in the right-side navigation.
4. Single-click an accessory image that you wish to have rendered in the workspace from the right-side navigation.

5. To position the item, click on the item in the virtual room. This will display the Product Alteration Menu.
6. You can move, rotate, edit or delete the item.

7. To deselect the item, click on an open area in the workspace.
Resizable Accessories

1. Select the Interior Design tab in the top navigation.
2. Select the Accessories tab in the top navigation.
3. Select the accessory category dropdown in the right-side navigation.
4. Resizable accessories will be labeled with “Resizable” in their name. Select an accessory image that you wish to have rendered in the workspace from the right-side navigation.

5. To change the dimensions, select the accessory in the virtual room to display the Product Alteration Menu.
   a. Use the slider bars or type the dimensions in the type fields.
6. For circular items, select the size options from the slider bars and the given radio (circle) buttons.

7. To position the item, select the item in the virtual room. This will display the Product Alteration Menu.

8. You can move, rotate, edit or delete the item.

9. To deselect the item, select an open area in the workspace.
Position a Fireplace in a Wall

1. Select the Interior Design tab in the top navigation.
2. Select the Floorplan tab in the top navigation.
3. Select the Doors category dropdown in the right-side navigation and choose opening.

4. Change the opening dimensions so that it is large enough to surround your fireplace but small enough that excess space is not shown.
5. Position the opening in the room by hovering over a wall. When the opening is in the desired position, click to add it to the room.
6. Select the Accessories tab in the top navigation.
7. Select the Fireplaces category dropdown in the right-side navigation.
8. Choose your desired fireplace by selecting the image to add it to the room.

9. Select the fireplace in the virtual room to display the Product Alteration Menu.
10. Left-click and hold on the move button. When you have the fireplace positioned in front of the opening, press the Ctrl button (while still left-clicking and holding) to allow the fireplace to pass into the wall.
These tools help you add, view and alter a product.

Workspace Movements: The Workspace Movements icons indicate how to utilize the mouse to rotate, zoom and move (right/left) the workspace. They are located on the bottom left corner of the workspace.

To rotate the workspace: left-click, hold and move your mouse in any direction.

To zoom in/out of the workspace: right-click, hold and move your mouse forward and back.

To move the workspace right/left: simultaneously right and left click your mouse, hold and move the view.

Anchor: The Anchor designates the center point of your workspace. Double-click in the workspace (on the grid/the flooring) to reposition your center point.

Workspace Orientation: The Workspace Orientation icons allow you to change how you are viewing the workspace orientation based on your Anchor position. They are located on the top right corner of the workspace.

Front View Orientation: To observe the front view of your workspace, select the icon on the left.

Aerial View Orientation: To observe the aerial view of your workspace, select the icon in the middle.

Front-Angled Orientation: To observe your workspace on a front-angled view, select the icon on the right.
Stationary Product Alteration Menu: The menu allows you to move, rotate, modify and delete a product. Single-click on a product to open the Stationary Product Alteration Menu.

Motion Product Alteration Menu: This menu allows you to move, rotate, modify, animate and delete a product. Single-click on a product to open the Product Alteration Menu.

Product Modification Icon: This function allows you to assign a product cover, change the product wood finish (when applicable) and change the configuration of a sectional (when applicable).

Measurements: To view the width and depth of the product select this tool from the bottom workspace navigation while in the Modify tab.

Left Rotate. To rotate the product to the left, single-click on the left rotate icon.

Right Rotate: To rotate the product to the right, single-click on the right rotate icon.

Delete: To remove the product (or entire Sectional) from the workspace, single-click the delete icon.

Play: To initiate animation on motion furniture, single-click the play button. To complete the animation, single-click the play button a second time.

Move Product: To move the product to a new position within the workspace, select and hold this icon.

Interior Design Tool Glossary

These tools are located in the Interior Design tab and help you create and modify your floorplan.

Select Tool: This tool allows you to select a wall, window or door to remove or modify.

Wall Tool: This tool allows you to draw a wall anywhere in your floorplan and to remove existing walls.

Split Floor Tool: This tool allows you to designate flooring areas in your workspace to apply differing floor materials.

Measurements Tool: This tool displays all of the wall measurements within your floorplan. You can also utilize this tool to draw your own measurements.

Floorplan Button: The floorplan tool allows you to upload a file of your current floorplan to use as reference points to build your workspace.

Custom Floorplan Toggle: The Custom Floorplan Toggle allows you to hide/unhide your uploaded floorplan from the workspace. This icon appears only when a floorplan has been uploaded using the Floorplan Button.
### Workspace Tool Glossary

The functionality of these tools is below the workspace. They allow you to complete tasks such as saving your workspace, clearing product from the workspace and obtaining a list of product within your workspace.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Allows you to start a new workspace.</td>
</tr>
<tr>
<td><strong>Picture</strong></td>
<td>This functionality will take a screenshot of your current workspace for future use outside of the 3D planner.</td>
</tr>
<tr>
<td><strong>Load</strong></td>
<td>To access saved rooms, select this icon.</td>
</tr>
<tr>
<td><strong>Save as</strong></td>
<td>Allows you to save your floorplan under the current, or a new saved name.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves your floorplan if you have already completed the save as command.</td>
</tr>
<tr>
<td><strong>Product Summary</strong></td>
<td>This tool presents a line list of your products within your workspace, you have the ability to print or save as a PDF.</td>
</tr>
<tr>
<td><strong>Clear</strong></td>
<td>Deletes the product (or entire sectional) you have selected when modifying the product in your workspace.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Deletes the currently selected product or end unit of a sectional. The selected product or unit of a sectional is identified by a red outline box.</td>
</tr>
<tr>
<td><strong>Print View</strong></td>
<td>This functionality will allow you to print the current workspace.</td>
</tr>
</tbody>
</table>
**Shortcuts**

These shortcuts allow you to add, move and alter products in sets.

**Multi-select Products:** Allows you to select multiple products to move, edit (if all products are the same style) or delete together. Once you click to another product, group or open area on the workspace your selected products will be deselected.

1. Products of the same style:
   1A. Hold down the **shift** key on your keyboard. Simultaneously, left-click and drag the box around your products OR select each product individually by holding down the **ctrl** key on your keyboard and simultaneously left-clicking on each desired product.
   1B. Since the selected products are the same style, you can use the modify tab to change the cover or wood finish at once.
   1C. You can move, duplicate or delete all the selected products at once.
   1D. To deselect a single product, hold down the **ctrl** key on your keyboard and simultaneously left-click the product a second time.
   1E. To deselect all of the products, left-click in an open area of the workspace.

2. Products of different styles:
   2A. Hold down the **shift** key on your keyboard. Simultaneously, left-click and drag the box around your products OR select each product individually by holding down the **ctrl** key on your keyboard and simultaneously left-clicking on each desired product.
   2B. Since the selected products are different styles, the modify tab is not functional.
   2C. You can move, duplicate or delete all the selected products at once.
   2D. To deselect a single product, hold down the **ctrl** key on your keyboard and simultaneously left-click the product a second time.
   2E. To deselect the entire group, left-click in an open area of the workspace.

**Group Products:** Allows you to select multiple products and group them together. They will remain as a group until the ungroup function is performed.

1. Products of the same style:
   1A. To select multiple products to group either hold down the **shift** key on your keyboard. Simultaneously, left-click and drag the box around your products OR select each product individually by holding down the **ctrl** key on your keyboard and simultaneously left-clicking on each desired product.
   1B. Group the selected products by holding down the **ctrl** and the **g** keys simultaneously on your keyboard.
   1C. Since the selected products are the same style, you can use the modify tab to change the cover or wood finish at once.
   1D. You can move, duplicate or delete all the selected products at once.
   1E. To ungroup the products select the group by left-clicking once on the group.
   1F. Hold down the **ctrl** and the **g** keys simultaneously on your keyboard a second time.

2. Products of different styles:
   2A. To select multiple products to group either hold down the **shift** key on your keyboard and simultaneously left-click and drag the box around your products OR select each product individually by holding down the **ctrl** key on your keyboard and simultaneously left-clicking on each desired product.
   2B. Group the selected products by holding down the **ctrl** and the **g** keys simultaneously on your keyboard.
   2C. Since the selected products are different styles, the modify tab is not functional.
   2D. To ungroup the products select the group by left-clicking once on the group.
   2E. Hold down the **ctrl** and the **g** keys simultaneously on your keyboard a second time.

**Duplicate Products or Groups:** Allows you to create a copy of a product or group in your workspace.

1. To duplicate products, select either a single product or group by left-clicking once on the product or group.
2. Duplicate the selected product or group by holding down the **ctrl** and the **d** keys simultaneously on your keyboard.